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An Archaeological Evaluation and assessment of LiDAR data of 

Land at Kates Hill, Rolleston Road,  

Billesdon, Leicestershire  

(SK 7218 0245) 

 

 

Wayne Jarvis and Matthew Beamish 

 

Summary 

 

Archaeological earthwork survey by assessment of LiDAR data and a trial trench 

evaluation was undertaken in September 2015 by University of Leicester 

Archaeological Services on behalf of Sandrion Ltd on land at Kates Hill, Rolleston 

Road, Billesdon, Leicestershire. The work was undertaken as part of a pre-planning 

enquiry in relation to proposals for the construction of a new residential development, 

and was carried out in order to assess the potential impact of the development on any 

archaeological remains that may be present.   

 

The trench evaluation did not identify any earthfast archaeological features. The 

frontage of the site had deep modern deposits surviving. The rest of the area was 

mostly under ridge and furrow earthworks. No artefacts were recovered during the 

works.  

 

The LiDAR assessment revealed some patterning to the ridge and furrow earthworks 

and gave indications on extent and survival, and possible remodelling. The extent of 

truncation of these field systems in the north was clarified, and some indications were 

made of other features to the immediate west of the proposed area. 

 

The site archive will be deposited with Leicestershire County Council under the 

accession number Accession Number XA.101.2015.  

 

Introduction 

 

An archaeological earthwork survey by LiDAR assessment and trench evaluation was 

undertaken at Kates Hill, Rolleston Road, Billesdon, Leicestershire in response to a 

pre-planning enquiry for residential development. In consequence Leicestershire 

County Council, acting in its role as advisor to the Local Planning Authority, 

recommended the need for a preliminary phase of archaeological investigation 

comprising a programme of evaluation trenching. The investigation was required in 

order to provide an adequate sample of the development area and to assess the likely 

archaeological impact of the development proposals. The agreed scheme was set out 

in a Written Scheme of Investigation (hereinafter WSI; ULAS 2015).  
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The fieldwork specified was intended to provide further indications of the character 

and extent of any buried archaeological remains in order that the potential impact of 

the development on such remains might be assessed. Fieldwork was carried out in 

September 2015 and involved the machine excavation of six 30m and two 15m x 

1.8m trenches, totalling c.350 sq. m in order to provide a c.5% sample of the area. The 

trenches were positioned in order to target the frontage of the site area, and 

earthworks surviving on site.  

 

The archaeological evaluation was undertaken in accordance with National Planning 

Policy Framework (NPPF) Section 12: Conserving and Enhancing the Historic 

Environment (DCLG March 2012). All archaeological work was in accordance with 

the Chartered Institute for Archaeologists (CIfA) Code of Conduct (2014) and 

adhered to their Standard and Guidance for Archaeological Field Evaluation (2014). 

The LCC Guidelines and Procedures for Archaeological work Leicestershire and 

Rutland (1997) was also adhered to.  

 

Site Description, Topography, Geology and Land Use 

 

The proposed development site lies to the east of Rolleston Road, Billesdon, 9.5 miles 

south-east of Leicester, in the Harborough district of Leicestershire (Figure 1). It 

consists of an area of c. 0.7 ha which is proposed for residential development (Figure 

3). 

The assessment area is currently two rough pasture fields with a building and trees in 

the northern field and north-west to south-east aligned ridge and furrow earthworks in 

the southern field. The ground climbs steeply from west to east, varying in height 

between c.80m and c.90m aO.D. and with a clear escarpment running broadly north-

south (Figure 6).  

The British Geological Survey website indicates that the underlying geology is likely 

to be Dyrham formation or Charmouth formation mudstone, overlain by sand and 

gravel on the northern part of the site. The trenching results have indicated a complex 

sequence of geological deposits on site. 

 

Archaeological and Historical Background 

 

The proposed development site lies in the south of the village of Billesdon, which is 

known to have medieval if not earlier origins (SK 7218 0245; Figure 1, Figure 3).  

 

A desk-based assessment has been prepared for a site c. 300m to the south-west (Hunt 

2014). The Leicestershire and Rutland Historic Environment Record indicates that the 

proposed development lies to the south-east of the historic settlement core of 

medieval Billesdon and is close to prehistoric and Roman sites. There is therefore 

some potential for archaeological deposits to be present within the area of the 

proposed development.  
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 Figure 1: Site Location (Scale 1:50 000)  

Reproduced from the Landranger 1:50000 map by permission of Ordnance Survey on behalf of The 

Controller of Her Majesty’s Stationery Office. © Crown Copyright 1996. All rights reserved. Licence 

number AL 100029495 

 

Aims and Objectives 

 

The archaeological evaluation was identified as having the potential to contribute to 

the following research aims. 

 

The Iron Age and Roman Periods (Taylor 2006; Willis 2006; Knight et al 2012; 

English Heritage 2012) 

 

There are known Iron Age and Roman sites within the vicinity including enclosures 

and a Roman road. The evaluation had the potential to contribute to knowledge on 

Iron Age – Roman transitions in rural settlement, landscape and society. Artefacts 

may identify trade links and economy. 

 

The Medieval period (Vince 2006, Lewis 2006, Knight et al 2012; English Heritage 

2012). 
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The evaluation had the potential to contribute towards research into the origins and 

development of medieval settlement, landscape and society. Environmental evidence 

could provide information on local environmental conditions as well as settlement 

activity, craft, industry and land use. Artefacts can assist in the development of a type 

series within the region and provide evidence for evidence for craft, industry and 

exchange across broad landscape areas. The evaluation has the potential to contribute 

to Research Agenda topics 7.1.2, 7.1.4, 7.2.1-7.2.4, 7.3.1-7.3.5, 7.5.4, 7.6.1-2, 7.7.1-

7.7.5 and Research Objective 7E - Investigate the morphology of rural settlements. 

 

The overall aim of the survey is to accurately record the visible ridge and furrow and 

other earthworks. 

 

The main objectives of the evaluation will be: 

 To identify the presence/absence of any archaeological deposits. 

 To establish the character, extent and date range for any archaeological deposits 

to be affected by the proposed ground works. 

 To produce an archive and report of any results. 

 

The results of the evaluation will enable reasoned and informed recommendations to 

be made to the local planning authority and, if appropriate, a suitable mitigation 

strategy for the proposed development to be formulated. 

 

This specification conforms to the requirements of the National Planning Policy 

Framework (2012). It has been designed in accordance with current best 

archaeological practice and the appropriate national standards and guidelines 

including: 

 

 Management of Archaeological Projects (English Heritage, 1991);  

 Model Briefs and Specifications for Archaeological Assessments and Field 

Evaluations (Association of County Archaeological Officers, 1994);  

 Code of Conduct (Institute for Archaeologists, 2010);  

 Standard and Guidance for Archaeological Field Evaluations (Institute for 

Archaeologists, 2010);  

 Standards for Field Archaeology in the East of England (Association of Local 

Government Officers, 2003);  

 Guidelines and Procedures for Archaeological work in Leicestershire and 

Rutland (Leicestershire County Council 1997)  

 

 

Methodology 

 

Archaeological Trial Trenches 

 

Prior to the commencement of works an Accession Code was requested (Accession 

Number XA.101.2015) and the required archive deposition forms completed. An 

OASIS online record was initiated and the key fields completed on Details, Location 

and Creator forms. Following recommendations from the Senior Planning 

Archaeologist of Leicestershire County Council, a programme of evaluation trenching 

was undertaken.  
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It was proposed that c.350 sq. m. of trenching, the equivalent of 7 trial trenches, each 

measuring 30m x 1.8m, be excavated in order to provide a c.5% sample. One trench 

was split into two 15m sections to allow site access. 

 

Topsoil and overburden was removed by a mechanical excavator using a toothless 

ditching bucket (c.1.8m wide), under archaeological supervision. The spoil generated 

during the evaluation was mounded away from the edges of each trench. Topsoil and 

subsoil was stored separately. Mechanical excavation ceased at undisturbed natural 

substrata or archaeological deposits. The trenches were recorded at an appropriate 

scale by measured drawing and photography and were GPS-located to Ordnance 

Survey National Grid.  

 

A photographic record, utilising high quality digital images, was maintained during 

the course of the fieldwork and included:  

 

 the site prior to commencement of fieldwork;  

 the site during work, showing specific stages of fieldwork;  

 Specific trench photographs and features 

 

Upon completion of the evaluation trenching, the excavated trenches were backfilled 

and loosely compacted.  
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Figure 2: South field of site area with trench layout shown. 
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Figure 3: North field of site area with trench layout shown. 

 

Results  

 

As set out in the Written Scheme of Investigation (WSI), 350 sq. m. of archaeological 

trial trenches were excavated. On site these comprised eight c.1.8m wide trenches (six 

at 30m in length, two at 15m).  The two 15m trenches were sited on the frontage 

adjacent to Rolleston Road, the rest away from this area including the south field 

where ridge and furrow earthworks survived.  

 

Excavation was undertaken using a 360 mechanical excavator fitted with a 1.8m wide 

toothless ditching bucket, with topsoil and overburden removed carefully in level 

spits, under continuous archaeological supervision.  

 

Trench Results 

 

The eight trenches were positioned as per the WSI, with very minor modifications due 

to site circumstances. Trench 2 had to be shortened slightly to allow for machine 

access. Trench 8 was shortened after a CAT scan indicated a live service feeding the 

farm building crossing the south end of the proposed trench line. Trenches 1-5 were in 

the south field of the proposed site, with Trenches 6-8 in the north field. Trench 1 ran 

parallel to and on the line of an earthwork ridge. Trenches 2 and 3 crossed the ridge 

and furrow. Trenches 4 and 5 crossed the hill slope obliquely where the ground drops 
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to the north and west. Trench 6 crossed the line of a trackway that climbs from the 

Rolleston Road frontage onto the plateau east of the proposed development area. 

There was no indication from Trench 6 of any antiquity to this trackway. Trenches 7-

8 were on the frontage in the lowest part of the site. The trench details are shown in 

the table below. 

 

Table 1 Details of trenches 
 

TRENCH 

 

AREA, 

LOCATION & 

ORIENTATION 

 

LENGTH 

AND WIDTH 

(metres) 

 

DESCRIPTION/NOTES 

 

DEPTH TO 

NATURAL 

(metres) 

 

1 

S, SK7223002370 

NW-SE 

31 x 1.8 Negative. NW-SE furrow, geological 

feature 

0.52-0.7 

 

2 

S, SK7220802375 

NE-SW 

27.7 x 1.8 Negative 0.44-0.8 

 

3 

S, SK7220502406 

NE-SW 

28 x 1.8 Negative, charcoally tree throw 0.45-0.9 

 

4 

S, SK7218702417 

NW-SE 

28 x 1.8 Negative, land drain 0.25-0.8 

 

5 

S, SK7220302448 

NW-SE 

28 x 1.8 Negative, land drain 0.32-0.9 

6 N, SK7217602483 

NW-SE 

25 x 1.8 Negative, small area of metalling only 0.34-0.65 

7 N, SK7214102476 

NW-SE 

11 x 1.8 Negative, modern deposits virtually to base 

at >0.7m 

0.7m 

8 N, SK7212002481 

NW-SE 

12 x 1.8 Negative, modern deposits to base at 1.25m  --- 

Area – N, S = North, South fields 

 

The trenches exposed a series of deposits with much variation in the natural 

substratum. Topsoil was present in all trenches, comprising a dark browny grey silty- 

clay up to 0.3m deep. The subsoil was a mid orangey brown sandy-clay, up to 0.6m 

deep. The natural substratum varied from a chalky gravelly sand (Trench 1 South 

end), to orange, brown and grey manganese clays, and solid ironstone (Trench 7). 

This was observed at varying depths of between 0.25m and 0.9m. It was shallowest in 

Trench 4 where a plug of hard grey clay was exposed, and deepest in Trenches 7 and 

8. 

All trenches were negative of convincing earthfast archaeological features. Trench 1 

exposed a linear feature, which had a steep asymmetrical profile and appeared to be of 

geological origin. A feature in Trench 3 somewhat pit-like proved to be very irregular 

in shape, with a loose fill and was probably a tree throw pit. Trench 6 exposed a small 

area of pebbly metalling that was in a shallow narrow grey clay linear feature, and 

was most likely consolidation of the steep ground here for farm plant. Good profiles 

through the ridge and furrow were observed (Figure 5). The ridge banks were much 

more substantial than the depth of the cuts of the furrows. The top of the ridges 

survived to a height of c.0.4m above the highest point of the furrows, and were spaced 

at between 5m and 10m apart. Interestingly, Trench 1 exposed a furrow running 

north-west to south-east under the line of the extant ridge on the same alignment 

(Figure 4), suggesting either a long life to the field system or perhaps a re-modelling 

of strips (see p.20). Trenches 7-8 on the frontage, where the ground was (artificially) 

level adjacent to a large hollow into the escarpment, exposed much modern 

disturbance. Between 0.7m and >1.2m of 19th-20th century deposits were observed. 

These deposits were well below the level of Rolleston road to the west. Only in the 

south-east of Trench 7 was natural observed, at a depth of 0.7m, and where a grey 
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clay overlay an outcrop of ironstone bedrock. It is possible that this large hollow into 

the escarpment could be from historic ironstone quarrying but no evidence for this 

was discovered. 

 
 

Figure 4: Trench 1, showing furrow at east of trench (right of image) under ridge. 
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Figure 5: Trench 2, showing ridge and furrow profile.  
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Figure 6: Trench 7, showing modern levels. Escarpment to rear of trench, with farm 

building in large hollow that cuts into escarpment. 

 

The LiDAR Analysis 

 

Introduction 

Archaeological earthwork survey by LiDAR study for land at Kates Hill, Rolleston 

Road, Billesdon Leicestershire (SK 721 024) has been undertaken. The assessment 

was commissioned by Sanrion from University of Leicester Archaeological Services 

(ULAS) in a pre-planning assessment of the proposed site. 

 

The LiDAR study has been commissioned with the aim of enabling clear assessment 

of the significance of the earthwork features within and immediately adjacent to the 

site. Specifically it is intended to clarify the location and state of preservation and 

extent of the ridge and furrow earthworks.  
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Figure 7: Extent of 1m resolution Lidar elevation data used in the assessment, along with Proposed 

Area. 

 

Methodology 

Following a search of Environment Agency archived data, composite aerial LiDAR 

data at 1m resolution was supplied electronically in ASCII file format by National 

Geomatics Unit of the Environment Agency. The area was flown and the data 

collected in November  2013: details of the data source are given below (p23). The 

data were acquired in DTM format, that has been filtered, where possible, to remove 

obstructions such as buildings and vegetation and provide a 'bare-earth' model. If the 

removal of any obstruction left a gap in the surface data this gap was interpolated by 

the EA (using an undisclosed algorithm) to provide a continuous surface. 

The methodology used followed that set out by Hannon (Hannon et al 2014, 8) with 

some modification. 

LiDAR ASCII Data Processing 

Most operations were conducted in Esri ArcMap10.1 SP1 build 3143. The Relief 

Visualisation Toolbox which enables the rapid output of multiple hillshade, slope 

Lidar source Environment Agency 2015 
Contains OS data © Crown copyright [and database right] (2015) 
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analysis, relief model and sky view analysis was also used (Zakšek et al. 2011; Kokal 

et al. 2011). 

Data files were imported into ArcGIS using the ASCII to Raster function (System 

Toolboxes>Conversion Tools>To Raster>ASCII to Raster), the output data type was 

set to ‘Float’ and the original ASCII filename was retained as the output raster name. 

These files were placed in a newly created file geodatabase called 

‘15638_Billesdon.gdb’.  

Creation of Hillshade layers 

To aid feature identification, four basic hillshade layers were generated for each 

LiDAR flight.  ‘Hillshades’ are a data processing method available in most GIS which 

allow an artificial sun to be shone from any chosen compass bearing and from angle 

above the horizon onto a DEM. This process helps identify ground features by casting 

an artificial shadow behind changes in elevation (for a full discussion of the process 

see Bewley et al 2005). 

Each of these layers were created using the hillshade function (System 

Toolboxes>Spatial Analyst Tools>Surface>Hillshade). The input raster for each 

hillshade was the DTM or the Clipped DEM if one was generated, for each LiDAR 

flight. Three basic parameters were utilised to generate the four different hillshade 

views and Z factor relating to the degree of exaggeration applied to the input DEM, 

with 1 indicating no exaggeration. 

Each output raster was named to preserve the original input DEM information and 

include the hillshade parameters (e.g.‘Bil1m_HS_315_45_1’) and saved to 

‘15638_Billesdon.gdb’. Once each hillshade was generated they were grouped within 

the TOC to aid navigation. 

Sky-View Factor Analysis  

‘Sky-View Factor’ (SVF) analysis was also applied to the LiDAR data (Zakšek et al 

2011). This method, instead of applying false shadows to a surface, calculates the 

volume of sky visible from a given position, a position at the bottom of a ditch affords 

a lower level of visibility to one atop a mound. This method produces a raster layer 

showing the volume of sky visible from each position within the raster which can 

highlight subtle archaeological features. SVF is not a function available in ArcMap, 

therefore a free to use version of the tool is available online (http://iaps.zrc-

sazu.si/index.php?q=en/svf). 

To utilise the tool the DEM for the area was exported as a TIFF. This was achieved by 

right-clicking on the DEM layer within the TOC (Data>Export Data) selecting a 

destination for the TIFF file and leaving all other parameters at default. Once the 

TIFF had been exported the SVF tool was run. The exported TIFF was used as the 

input DEM and Search Radius was left at the default 10. The Vertical exaggeration 

was set to either 1, 2 or 3 and Direction set to either 16 or 32, multiple Sky-Views 

were run for each focus area using a range of values. The tool created an output TIFF 

file which reflected the name of the input DEM and settings used (e.g. 

‘LiDAR_1m_SVF_d32_r10_ve3’). This TIFF was then imported into ArcMap and 

added to the TOC. 

http://iaps.zrc-sazu.si/index.php?q=en/svf
http://iaps.zrc-sazu.si/index.php?q=en/svf
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The SVF images were then also interrogated and potential features recorded in the 

same manner as is detailed above for the initial feature identification process. 

Profiles 

Profiles were generated with ARCGIS from the DTM data using the 3d Analyst tool, 

Interpolate line, choosing the profile line and Profile Graph options.  

Images were processed in Standard Raster image and CAD packages. 

Results 

 

Two ridge and furrow field systems are within the proposed area (Figure 9, Figure 

10).  

 

The more eastern of the field systems comprises sinuous features that vary between 

4.7 and notably wide lands of 11.1 m in width, running from northwest to southeast 

on a southeast facing slope. Amplitude is up to 0.70m (Figure 11, A). The system is 

some 210m long and appears complete with reverse S curve visible at both ends, and 

some headlands visible (Figure 9, A & B). Wide and narrow strips appear to be 

grouped together – i.e. there is some patterning in the width of the features within the 

system. 

 

The more western system comprises generally straight and parallel features at 

between 5 and 6m apart running southwest to north east on a north facing slope. 

Amplitude is less than 0.20m (Figure 11, B). This system survives to 90m long but is 

truncated in the south-west and south-east.  

 

In the northwest of the proposed area, tree canopies visible in aerial imagery have 

been successfully removed by filtering of the LiDAR (Figure 8). A sharply defined 

negative feature appears to truncate the ridge and furrow (Figure 11, Profile C). 

 

A broad negative feature with central field boundary runs for approximately 70m 

from south-west to north-east between the two field systems (Figure 11, Profile D) 

and away from the proposed area. The feature is clearly defined in the south, but 

becomes less so as it narrows from 30m to 16m wide. The western side of the feature 

is concave in plan, suggesting that the feature is curving to the east. The feature 

appears to truncate the ridge and furrow on its north side in this area (Figure 12, F). 

 

Broadly in line with the northern end of the broad feature an earthwork mound is 

clearly visible, and is sharply defined at its southern end (Figure 10, G). The feature 

appears to post-date the ridge and furrow which does not run across it, and the area 

has been enclosed by the late 19
th

 Century (Figure 9 and Figure 13). In data shaded by 

a north-westerly light source, earthworks extends to the north-west (Figure 12) where 

ridge and furrow strips clearly extended (e.g. Figure 13), and therefore there appears 

to be earthworks both pre-dating and post-dating the ridge and furrow. The mound is 

40m long by 25m wide and survives to 1m in height.  
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Figure 8: Google Earth (27/9/2011) with proposed area. 



An Archaeological Evaluation and Assessment of LiDAR data of Land at Kates Hill, Rolleston Road, Billesdon, Leicestershire  

 

ULAS Report No. 2015-137 Acc. No. XA.101.2015 16 

 
Figure 9: Proposed area with hillshade plot from northeast of DTM lidar data.  

 

Lidar source Environment Agency 2015 
Contains OS data © Crown copyright [and database right] (2015) 
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Figure 10: Skyview model of 1m resolution DTM data with coloured DTM elevation model below, and 

the location of profiles A to E, and trenches 1-8, and earthwork at G. 

 

 

Lidar source Environment Agency 2015 
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Figure 11: Profiles of filtered LiDAR elevation data through ridge and furrow and other features at the same horizontal scale. All units are in metres, and heights in m AOD. 

Profile A, C, D and E is x2 Z axis. Profile B is x4 Z axis. 
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Figure 12: Hillshade from northwest of 1m DTM data, with Profile locations, and observation F. A 

clear mound is visible within the yellow line 

 
Figure 13: Skyview plot overlying shade plots with 1st edition Ordnance Survey. Ridge and furrow 

extends over the northeast end of the mound identified in Figure 12, while the southwest end is within a 

small enclosure. 

 

Lidar source Environment Agency 2015 

Lidar source Environment Agency 2015 
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Discussion and Conclusions 

 

The evaluation by trial trenching on land at Kates Hill, Billesdon did not identify any 

archaeological features. The frontage has had significant modern disturbance to a 

depth of more than 0.7m. The ridge and furrow across the majority of the rest of the 

site indicates one or more historic periods of ploughing, but below this level no earlier 

activity was identified by trenching and no artefacts were recovered during the 

fieldwork. 

 

At above 5m in width the ridge and furrow identified in the proposed area is of broad 

rig character and is probably of medieval date. Ridge and furrow spaced at less than 

5m centres is termed narrow rig and has been shown to be of later post-medieval date. 

Broad rig is thought to have been formed by the Ox drawn plough, and Narrow rig by 

horses. Narrow rig in places may relate to cultivation of new land in the Napoleonic 

period when pressure for domestic grain production increased. 

 

LiDAR data has revealed that a medieval field system incorporates ridges of 

differentiated width with strips arranged in groups. Trenching of one the broader 

ridges (Trench 1) has indicated that an earlier furrow lies below the wider ridge on the 

same alignment. A tentative interpretation of this information is that at some stage the 

field system has to a been re-modelled, with uniform strips of c.6m width in places 

combined into wider strips of 10m or more in width. No earlier furrows were 

positively identified in Trench 3. 

 

A negative feature, perhaps the remains of a hollowed track runs away from the 

proposed area to the north. 40m to the north of the proposed area, an earthwork 

mound appears to both pre and post-date the ridge and furrow field system.  

Modelling of the data in a 3D viewer shows the earthwork mound to sit at the apex of 

the hillside, and it is quite possible that the remains of a windmill-mound survive 

here, possibly served by a trackway along which grain was supplied and milled 

products delivered. 

 

The 1814 survey for this area was checked, but no mill or other feature survived in 

this location into the early 19th Century (Figure 14). 
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Figure 14: Extract of Ordnance Surveyor Henry Stevens’ drawing of Leicestershire, British Library, 

1814. British Library, OSD 262. Original scale 2'' to 1 Mile (1:31680) with proposed area indicated. 

 

 

 

 

 

 

 

 

 
 

Figure 15: Pseudo 3 dimensional view of Skyview model based on ground heights looking north, 

showing proposed area, and trench locations. Ridge and furrow earthworks, possible track-way and 

mounds pre-dating and post-dating the ridge and furrow are all visible. 
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Archive and Publications 

 

The site archive (XA.101.2015), consisting of paper and photographic records, will be 

deposited with Leicestershire Museums Service. 

 

The archive consists of: 

 8 trench recording sheets  

 Photographic record index 

 Digital photographs on CD and contact prints 

 Unbound copy of this report (2015-137) 

 

Publication 

 

A version of the evaluation summary (see above) will appear in due course in the 

Transactions of the Leicestershire Archaeological and Historical Society.  
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Oasis Information 

 

Appendix: LiDAR metadata  

FILENAME TILENAME DATE_FLOWN %_COVERAGE POLYGON_ID RESOLUTION 

(m) 

Project Name Land at Kates Hill, Rolleston Road, Billesdon, Leicestershire 

Project Type Archaeological evaluation 

Project Manager Patrick Clay 

Project Supervisor Wayne Jarvis 

Previous/Future work Development  

Current Land Use Pasture and farmyard 

Development Type Residential 

Reason for Investigation NPPF 

Position in the  

Planning Process 

Pre-determination 

Site Co ordinates  NGR SK 7218 0245 

Start/end dates of field work  September 2015 

Archive Recipient Leicestershire County Council 

Study Area  0.7ha. 
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